
Oracle® Retail Pricing Cloud Service/
Pricing
Do the Basics User Guide

Release 19.3
F44234-01
August 2021



Oracle Retail Pricing Cloud Service/Pricing Do the Basics User Guide, Release 19.3

F44234-01

Copyright © 2021, Oracle and/or its affiliates.

Primary Author:

Contributing Authors:

Contributors:

This software and related documentation are provided under a license agreement containing restrictions on
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If
you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on
behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs (including any operating system, integrated software,
any programs embedded, installed or activated on delivered hardware, and modifications of such programs)
and Oracle computer documentation or other Oracle data delivered to or accessed by U.S. Government end
users are "commercial computer software" or "commercial computer software documentation" pursuant to the
applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use,
reproduction, duplication, release, display, disclosure, modification, preparation of derivative works, and/or
adaptation of i) Oracle programs (including any operating system, integrated software, any programs
embedded, installed or activated on delivered hardware, and modifications of such programs), ii) Oracle
computer documentation and/or iii) other Oracle data, is subject to the rights and limitations specified in the
license contained in the applicable contract. The terms governing the U.S. Government’s use of Oracle cloud
services are defined by the applicable contract for such services. No other rights are granted to the U.S.
Government.

This software or hardware is developed for general use in a variety of information management applications.
It is not developed or intended for use in any inherently dangerous applications, including applications that
may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its
safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this
software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Intel and Intel Inside are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are
used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Epyc,
and the AMD logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered
trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products,
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly
disclaim all warranties of any kind with respect to third-party content, products, and services unless otherwise
set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be
responsible for any loss, costs, or damages incurred due to your access to or use of third-party content,
products, or services, except as set forth in an applicable agreement between you and Oracle.



Contents

 Send Us Your Comments

 Preface

Audience vi

Documentation Accessibility vi

Customer Support vi

Review Patch Documentation vi

Improved Process for Oracle Retail Documentation Corrections vii

Oracle Retail Documentation on the Oracle Help Center vii

Conventions vii

1   Log In and Out

Log on to the Application 1-1

Log Out of the Application 1-1

2   User Help

3   Common Actions and Icons

Task Bar Options 3-1

Application Navigator 3-2

Favorites 3-2

Tasks 3-3

Reports 3-4

Screen Level 3-5

Screen Level Action - Icons and Buttons 3-5

View all the Sections Within a Window 3-6

Table Level 3-6

Action Menu and Icons 3-6

View Menu 3-8

iii



Search Screens 3-9

Search for a Record Through the Basic Search Criteria 3-10

Search for a Record Through the Advanced Search Criteria 3-11

Personalize Saved Search 3-13

Create Saved Search 3-13

4   Set User Preferences

Regional Options 4-1

Language Options 4-1

Accessibility Options 4-2

Accessibility 4-2

Configure Application for Screen Reader Mode 4-3

Set Accessibility to Default 4-4

5   View Data Loading Status

Table 5-1

Table - Actions Menu and Icons 5-1

Data Loading Status - View Menu and Icons 5-2

Data Loading Status Toolbar 5-3

6   Download Blank Templates

7   Notifications

Notification Badge 7-2

Notification Sidebar 7-3

Search Bar 7-3

Filtering Panel 7-4

Grouping Panel 7-5

Results Panel - List View 7-5

Results Panel - Grouped View 7-6

Results Panel - Summarized View 7-7

All Notifications Tab 7-8

Upload List 7-11

8   Add Items by Upload List

iv



Send Us Your Comments

Oracle Retail Pricing Cloud Service/Pricing Do the Basics User Guide, Release 19.3

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this
document.

Your feedback is important, and helps us to best meet your needs as a user of our products.
For example:

• Are the implementation steps correct and complete?

• Did you understand the context of the procedures?

• Did you find any errors in the information?

• Does the structure of the information help you with your tasks?

• Do you need different information or graphics? If so, where, and in what format?

• Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your
name, the name of the company who has licensed our products, the title and part number of
the documentation and the chapter, section, and page number (if available).

Note:

Before sending us your comments, you might like to check that you have the latest
version of the document and if any concerns are already addressed. To do this,
access the Online Documentation available on the Oracle Help Center Web site. It
contains the most current Documentation Library plus all documents revised or
released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative
or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle
local office and inquire about our Oracle University offerings. A list of Oracle offices is
available on our Web site at http://www.oracle.com.

v
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Preface

This document describes the Merchandising user interface. It provides step-by-step
instructions to complete most tasks that can be performed through the user interface.

Audience
This document is for users and administrators of Oracle Retail Merchandising. This
includes merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=trs if you are hearing impaired.

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

• Product version and program/module name

• Functional and technical description of the problem (include business impact)

• Detailed step-by-step instructions to re-create

• Exact error message received

• Screen shots of each step you take

Review Patch Documentation
When you install the application for the first time, you install either a base release (for
example, 19.0) or a later patch release (for example, 19.0.001). If you are installing the
base release, additional patch, and bundled hot fix releases, read the documentation
for all releases that have occurred since the base release before you begin installation.
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Documentation for patch and bundled hot fix releases can contain critical information related
to the base release, as well as information about code changes since the base release.

Improved Process for Oracle Retail Documentation Corrections
To more quickly address critical corrections to Oracle Retail documentation content, Oracle
Retail documentation may be republished whenever a critical correction is needed. For
critical corrections, the republication of an Oracle Retail document may at times not be
attached to a numbered software release; instead, the Oracle Retail document will simply be
replaced on the Oracle Help Center Web site, or, in the case of Data Models, to the
applicable My Oracle Support Documentation container where they reside.

This process will prevent delays in making critical corrections available to customers. For the
customer, it means that before you begin installation, you must verify that you have the most
recent version of the Oracle Retail documentation set. Oracle Retail documentation is
available on the Oracle Help Center at the following URL:

https://docs.oracle.com/en/industries/retail/index.html

An updated version of the applicable Oracle Retail document is indicated by Oracle part
number, as well as print date (month and year). An updated version uses the same part
number, with a higher-numbered suffix. For example, part number E123456-02 is an updated
version of a document with part number E123456-01.

If a more recent version of a document is available, that version supersedes all previous
versions.

Oracle Retail Documentation on the Oracle Help Center
Oracle Retail product documentation is available on the following Web site:

https://docs.oracle.com/en/industries/retail/index.html

(Data Model documents are not available through Oracle Help Center. You can obtain them
through My Oracle Support.)

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.
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1
Log In and Out

Log on to the Application
To log on to the application:

1. Click the User list which is to the top right of the Oracle Merchandising window.

Figure 1-1    User List Screen

2. Click Login. The Welcome screen appears.

Figure 1-2    Welcome Screen

3. Provide the following login information:

a. Enter your user name in the Username field.

b. Enter your password in the Password field.

4. Click Login.

Log Out of the Application
Use the User list menu, which is to the top right of the Oracle Merchandising window, to log
out of the application.
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Figure 1-3    Logging Out of the Application

Chapter 1
Log Out of the Application
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2
User Help

This application contains an online HTML help that can guide you through the user interface.
User information is included to describe high-level processes and procedures, as well as
provide step-by-step instructions for completing a task.

You can access online help for a particular page by clicking on the Help link at the top of the

application home page or by clicking the Help icon  on every page of the application. Once
in the help, you can access additional information through the table of contents or by using
the index.
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3
Common Actions and Icons

This chapter describes the features and functions used by all users, and the procedures
describing how to use them.

This chapter contains the following sections:

• Task Bar Options

• Screen Level

• Table Level

• Search Screens

Task Bar Options
You can quickly access the tasks of current applications and switch to other applications from
the Navigation bar.

Figure 3-1    Navigation Bar

The following navigation bar options are common across all the applications:

• Application Navigator

• Favorites

• Tasks
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• Notifications

• Reports

Application Navigator
The Application Navigator is optional for the application and provides the ability to
switch between applications.

Note:

Your view may vary, depending upon the features selected during the setup
process.

To switch between applications:

1. At the top left of the application, click the Application Navigator  icon to open
the list of available applications.

Figure 3-2    Application Navigator

2. Select the listed applications. The application will open in a new tab.

Favorites
You can select your favorite tasks without accessing the Tasks menu. It helps you
quickly get into your frequently used tasks.

You can click the Favorites icon in the Tasks menu to access tasks designated as
favorites. You can also select the cog icon from the Favorites menu to edit the favorite
list. Tasks can be selected or deselected as favorites in the Tasks menu.

Chapter 3
Task Bar Options
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Figure 3-3    Favorites Area

Tasks
Oracle Retail applications support a variety of navigational tools and methods that allow you
to move efficiently between application pages. Information on how to use and manage each
of the tools and methods is included in this section.

A task is a set of links to a series of task flows organized in a specific sequence to
accomplish a business process or procedure. For example, tasks can be defined for common
multi-step procedures or processes so that you can quickly step through tasks. By navigating
sequentially to the pages outlined in the task, you are assisted in stepping through the
business process or activity.

Your Tasks list appears on the top left side of the home page. All of the tasks to which you
have access are listed on the Tasks window. You can either click on the specific task name to
open, or use the Task Search component to search for a Task that you want to open.

To begin working with a task, choose the application feature or process from the list.

Note:

Your task menu may appear slightly different, depending on your retail application.

Chapter 3
Task Bar Options
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Figure 3-4    Tasks Menu

Reports
The functionality of Reports works similar to the Tasks menu.

Chapter 3
Task Bar Options
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Figure 3-5    Reports Menu

Screen Level

Screen Level Action - Icons and Buttons
The screen level actions display the icons and buttons.

Figure 3-6    Screen Level Action - Icons and Buttons

Chapter 3
Screen Level
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Table 3-1    Screen Level Action - Icons/Buttons and Descriptions

Icon/Buttons Description

Help icon 
You can access online help for a particular page by clicking the
Help icon.

Expand and Collapse icon You can view all and collapse all the sections in the application
window by clicking the Expand and Collapse icon.

Delete icon 
You can delete a deal component by selecting the Delete icon.

Status Action Button Depending on the status of your deals, the status action button
displays. For example, Submit.

Wherever applicable, this button will be available to change the
status of an entity. The status will be changed to the label
specified on the button. If there is more than one status to which
the entity can be changed, clicking the arrow on the right side of
the button will display the additional status options.

More Actions The More Actions button will have any additional actions and
options for navigating to other screens.

Save Click Save to save the created deals and stay in the Deal
window.

Save and Close Click Save and Close to save the deals and exit the Deal
window.

Cancel Click Cancel to reject the deal and exit the Deal window.

View all the Sections Within a Window

You can view all the sections in the window by clicking the Expand icon . You can

shrink all the sections in the window by clicking the Shrink icon .

Table Level

Note:

Figure 3-7, Figure 3-8, Figure 3-9 are mere representation and may be
different for every window/table/popup.

The Actions menu, View menu, and icons are displayed in the form of a table. For
more information on these options, see the sections Action Menu and Icons and View
Menu.

Action Menu and Icons
The Actions menu provides the option to take different actions related to entries in the
table. Depending on the nature of the table, these actions can be add, view, delete or
edit table rows, create by moving to a new screen or export the table contents to the

Chapter 3
Table Level
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spreadsheet. Alternatively these actions can also be performed by using the icon buttons on
the table toolbar. For more information on the icon/buttons, see the Screen Level Action -
Icons and Buttons.

In some tables, it may also contain some table specific actions.

Figure 3-7    Actions Menu and Icons of Components Section

Table 3-2    Actions Menu/Icons and Descriptions of Components Section

Actions Menu/Icon Description

Add and Add icon 
Add a row or record by clicking Add in the Actions menu or by clicking

the Add icon .

Edit and Edit icon 
You can edit a row or record by clicking Edit in the Actions menu or by

clicking the Edit icon .

Delete and Delete icon 
You can delete a row or record, by clicking Delete in the Actions menu

or by clicking the Delete icon .

Export to Excel icon 
You can save the table to a Microsoft Excel spreadsheet by clicking
the Export to Excel option in the Actions menu or by clicking the

Export to Excel icon .

Move Up and Down icon You can move up and down the components to change the order in
which they will be applied by clicking the Move Up and Down icons

.

Wrap icon You can wrap the values in the table column by using the Wrap icon

 option.

Chapter 3
Table Level
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Figure 3-8    Actions Menu and Icons of Managing a Deal

Table 3-3    Actions Menu/Icons and Descriptions of Managing a Deal

Actions Menu/Icon Description

Create and Create icon 
You can create a record by clicking Create in the Actions menu

or by clicking the Create icon .

Create from Existing icon You can create a new record from an existing record by clicking
Create from Existing in the Actions menu or by clicking the

Create from Existing icon .

Edit and Edit icon 
You can edit a record by clicking Edit in the Actions menu or by

clicking the Edit icon .

View and View icon You can view a record by clicking View in the Actions menu or by
clicking the View icon .

Export to Excel icon 
You can save the table to a Microsoft Excel spreadsheet by
clicking the Export to Excel option in the Actions menu or by

clicking the Export to Excel icon .

Wrap icon You can wrap the values in the table column by clicking the Wrap

icon  option.

View Menu
The View menu provides the options for managing the table columns and sorting and
filtering the table data.

In some tables you have the option to choose a saved custom view, which is an
arrangement of columns different from the default view of the table.

Chapter 3
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Figure 3-9    View Menu of Components Section

Table 3-4    Components Section - View Menu and Descriptions

View Menu List Description

Columns You can manage which of the columns will be shown in the table by
clicking the Show All and Manage Columns options.

Detach You can view the tables in the application in a separate window by

clicking Detach or by clicking the Detach icon .

Sort You can sort columns by the following options:

• Ascending
• Descending
• Advanced

Reorder Columns You can reorder columns by clicking the Reorder Columns option.

Query by Example You can filter the record components by one or multiple column values
by clicking the Query by Example option or by clicking the query by

example icon .

Search Screens
You can search for a particular entity by entering, selecting, or searching in the
Merchandising application, for example to search for a deal.

To search for a deal:

1. From the Tasks menu, select Orders > Deals > Manage Deal. The Deal Search window
appears.

2. You can search for a deal by providing search criteria in the search section. The criteria
can be provided either in Basic or Advanced mode, depending on the requirement. Basic
is the default mode when the search screen is entered. Click Advanced to access the
search panel in advanced mode. You can return to Basic mode by clicking Basic.

Chapter 3
Search Screens
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Search for a Record Through the Basic Search Criteria
To search for a record through the basic search criteria:

1. Enter or select one or all of the following basic search criteria.

Table 3-5    Basic Search Criteria

Search Field Description

Deal Enter the deal ID.

Deal Type Select the deal type. The options are: Annual, Promotional,
PO Specific, and Vendor Funded Markdown.

Status Select the status of the deal. The options are: Worksheet,
Submitted, Approved, Rejected, Closed.

Billing Type Select the type of deal being created. The options are: Off
invoice, Bill Back, Bill Back Rebate, Vendor Funded
Promotion, Vendor Funded Markdown.

Vendor Type Select the vendor type.

Vendor Enter, select or search for the vendor.

Active Date Enter the date on which the deal becomes active, or click the
calendar icon and select the date.

Close Date Enter the date on which the deal ends, or click the calendar
icon and select the date.

Figure 3-10    Search Section in Basic Search Mode

2. You can also click on the Saved Search drop down to select one of the saved sets
of search criteria. Selecting a saved search will populate the criteria section with
saved criteria. If the saved search is selected to run automatically, then the search
will be executed too.

You can also choose to manage and personalize the saved searches by clicking
Personalize in the list. The Personalize Saved Searches window appears. For
more information on the Personalize Saved Searches, see the section Personalize
Saved Search.

3. Click Search. The deals that match the search criteria are displayed in the Results
section.

Chapter 3
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Figure 3-11    Search Results

4. Click Reset to execute the saved search.

5. Click the Save.. button to save the current set of search criteria as a Saved Search. The
Create Saved Search window appears. For information on the Create Saved Search
window, see the section Create Saved Search.

6. Click Done to close the window.

Search for a Record Through the Advanced Search Criteria
To search for a deal through the advanced search criteria:

1. Enter or select one or all of the following advanced search criteria.

Table 3-6    Advanced Search Criteria

Search Field Description

Deal Enter the deal ID.

Deal Type Select the deal type.

Status Select the status of the deal.

Billing Type Select the type of deal being created.

Vendor Type Select the vendor type.

Vendor Enter, select or search for the vendor.

Active Date Enter the date on which the deal becomes active, or click the
calendar icon and select the date.

Close Date Enter the date on which the deal ends, or click the calendar icon
and select the date.

External Ref. No. Enter the external reference number.

Order No. Enter, select or search for the order number.

Deal Component Type Select the deal component type.

Rebate Select Yes if the rebate is included in the deal or select No if the
rebate is not included in the deal.

Chapter 3
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Table 3-6    (Cont.) Advanced Search Criteria

Search Field Description

Promotion Enter, select or search the promotion from the list.

Division Enter the division number, select or search for the division name
and number.

Group Enter the group number, select or search for the group name and
number from the list.

Department Enter the department number, select or search for the department
name and number from the list.

Class Enter the class number, select or search for the class name and
number from the list.

Subclass Enter the subclass number, select or search for the subclass name
and number from the list.

Item Enter the item number, or search by using the search icon.

Chain Enter the chain number, select or search for the chain name and
number from the list.

Area Enter the area number, select or search for the area name and
number from the list.

Region Enter the region number, select or search for the region name and
number from the list.

District Enter the district number, select or search for the district name and
number from the list.

Location Enter the location number, select or search for the location name
and number from the list.

Figure 3-12    Search Section in Advanced Search Mode

2. You can also click the Saved Search drop down to select one of the saved sets of
search criteria. Selecting a saved search will populate the criteria section with
saved criteria. If the saved search is selected to run automatically then the search
will be executed too.

You can also choose to manage and personalize the saved searches by clicking
Personalize in the list. The Personalize Saved Searches window appears. For
more information on the Personalize Saved Searches, see the section Personalize
Saved Search.

3. Click Search. The deals that match the search criteria are displayed in the Results
section.

Chapter 3
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4. Click the Save... button to save the current set of search criteria as a Saved Search. The
Create Saved Search window appears. For information on the Create Saved Search
window, see the section Create Saved Search.

5. Click Done to close the window.

Personalize Saved Search
Select Personalize in the Saved Search list to view the personalized saved search. The
Personalize Saved Searches pop up allows you to edit, copy, or delete Saved Searches.

Figure 3-13    Personalize Saved Searches Window

Create Saved Search
You can create a Saved Search by selecting the Save button in the Search Criteria panel
after you have entered the criteria for your search. The Save button will call up the Create
Saved Search window, where the search is given a name and the user determines whether it
should be the default search as well as whether it should be run automatically.

To view the created saved search:

1. Click the Save.. button. The Create Saved Search window appears.

Chapter 3
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Figure 3-14    Create Saved Search Window

2. Enter the name of the search.

3. You can also choose to save the combination of the search criteria by selecting the
following check boxes:

• Set as default

• Run automatically

Chapter 3
Search Screens
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4
Set User Preferences

The Preferences pages are where you specify the default regional, language, and
accessibility settings that you want to use throughout the system.

To set your preferred preferences, click User list > Preferences at the top of the application
home page. The Preferences page appears. The standard preference options available are
as follows:

• Regional

• Language

• Accessibility

To return to the application home page, click Back to Home at the top of the page. The
Preferences pages are where you specify the default regional, language, and accessibility
settings that you want to use throughout the system.

Regional Options
Use the following options to specify the default formats for territory, date, time, number, and
time zone you want to use throughout the system.

Table 4-1    Regional Options

Value Description

Territory Specify the country details.

Date Format Select the date format that you want to use.

Time Format Select the time format that you want to use.

Number Format Select the number format that you want to use.

Time Zone Select the time zone you want to use.

Language Options
Use the following options to specify the default language you want to use throughout the
system.

Table 4-2    Language Options

Value Description

Default Specify the default language you want to use.

Current Session Specify the language you want to use for the current session.
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Accessibility Options
Use the following options to specify the default accessibility preferences you want to
use throughout the system.

Table 4-3    Accessibility Options

Value Description

Accessibility Select the accessibility option you want to apply.

Color Contrast Specify the color contrast that you want to use.

Font Size Specify the font size that you want to use.

Accessibility
Accessibility involves making your application usable for differently abled persons such
as low vision or blindness, deafness, or other physical limitations. This means creating
applications that can be used without a mouse (keyboard only), used with a screen
reader for blind or low-vision users, and used without reliance on sound, color, or
animation and timing.

The Merchandising solutions provides the ability for users to switch between
accessibility support levels in the application, so that users can choose their desired
type of accessibility support, if required. They do so by exposing a user preferences
screen in which the user can specify the accessibility preferences/mode which will
allow the user to operate in that mode.

• Default Mode: By default, the Merchandising solutions a have rich user interface
interaction, and are also accessible through the keyboard. Note that in the default
mode, screen readers cannot access all components. If a visually impaired user is
using a screen reader, it is recommended to use the Screen Reader mode.

• Screen Reader: Merchandising solutions are optimized for use with screen
readers. The Screen Reader mode facilitates the display for visually impaired
users, but will degrade the display for sighted users (without visual impairment.

Additional fine grained accessibility levels as described below are also supported:

• High-contrast: Merchandising solutions can display high-contrast-friendly visual
content. High-contrast mode is intended to make the solutions compatible with
operating systems or browsers that have high-contrast features enabled. For
example, they changes its use of background images and background colors in
high-contrast mode to prevent the loss of visual information. Note that the
Merchandising solutions high-contrast mode is more beneficial if used in
conjunction with your browser's or operating system's high-contrast mode. Also,
some users might find it beneficial to use large-font mode along with high-contrast
mode.

• Large-fonts: Merchandising solutions also support browser-zoom-friendly content.
In default mode, most text and many containers have a fixed font size to provide a
consistent and defined look. In large-font mode, text and containers have a
scalable font size. This allows the solutions both to be compatible with browsers
that are set to larger font sizes and to work with browser-zoom capabilities. Note
that if you are not using large-font mode or browser-zoom capabilities, you should

Chapter 4
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disable large-font mode. Some users might also find it beneficial to use high-contrast
mode along with the large-font mode.

Merchandising/Sales Audit provides the ability to switch between the above accessibility
support levels in the application, so that users can choose their desired type of accessibility
support, if required. It exposes a user preferences screen in which the user can specify the
accessibility preferences/mode which will allow the user to operate in that mode.

Configure Application for Screen Reader Mode
Users can configure their session to the accessibility mode by setting user references on the
home page of the application as shown below. Perform the following procedure to configure a
user preference for screen reader mode.

1. Log into one of the Merchandising solutions. In this example, we use Merchandising.

2. From the application home page, select Preferences from the logged in user menu.

Figure 4-1    Logged-in User Menu

3. From the Tasks pane, click Accessibility to open the Accessibility tab.

Chapter 4
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Figure 4-2    Accessibility Tab

4. Select Screen Reader to enable accessibility mode, and click Save.

Figure 4-3    Enabling the Screen Reader

5. Click on Back to Home to return to the home page. Now the application is enabled
in the screen reader mode to assist a visibly challenged user. Some of the
graphical content of Operational Insights is also displayed in a tabular mode.

Set Accessibility to Default
Perform the following procedure to set Accessibility mode to Default mode.

1. From the application home page, select Preferences from the logged in user
menu.
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Figure 4-4    Logged-in User Menu

2. From the Tasks pane, click Accessibility to open the Accessibility tab.

Figure 4-5    Accessibility Tab

3. Select Default mode.
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Figure 4-6    Accessibility Settings

4. Click Save to save the settings.

5. Click Back to Home to return to the home page. Application is returned to default
mode and you can view graphical reports.
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5
View Data Loading Status

The Data Loading Status window allows you to view the status of the upload and download
processes happening in the Merchandising solutions, so that you can rectify the issues
associated with the upload/download process.

The window allows you to drill down to the errors or warnings associated with a selected
upload/download request.

You can access the Data Loading Status window from the Task menu, select Foundation
Data > Data Loading > Review Status. The Data Loading Status window appears.

The Data Loading Status window contains the following sections.

• Table

• Data Loading Status Toolbar

Figure 5-1    Data Loading Status Window

Table
The table displays the process, process description, file name, template category and type,
destination, action date and time, status and the user, who initiated the process.

Table - Actions Menu and Icons
Use the Actions Menu and icons to apply actions to the table. You can perform the actions
listed below.
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Table 5-1    Data Loading Status Table - Actions Menu/Icons and Description

Actions Menu/Icons Description

Delete and Delete icon 
You can delete a process by using the following steps:

• Select a record in the table.
•

Select Actions > Delete or use the Delete icon .
• You are prompted, if you want to delete the record. Select

Yes to confirm the prompt.
• The record is deleted from the table.

Export to Excel and Export

to Excel icon 

You can export the records in the table to a Microsoft Excel
spreadsheet by selecting Actions > Export to Excel or by using

the Export to Excel icon .

View Issues and View
Issues button

To view the warnings and errors associated with a selected
upload/download request:

• Select a record in the table.
• Select Actions > View Issues or use the View Issues

button. The Issues window appears.
• Click Done to close the window.

Upload to RMS With this option you can upload the selected process from
Staging to RMS.

This option is only enabled for records which have Staging
Tables as a destination and do not hold the status “Processed
with Errors". Additionally, this option is only enabled for Item
induction, Cost Change induction and Order induction records.

Download Staged This option allows you to download the staged records of a
process to a spreadsheet.

• Select a record in the table.
• Select Actions > Download Staged. The staged record are

downloaded to your desktop.
This option is only enabled for Item induction, Cost Change
induction and Order induction records.

Data Loading Status - View Menu and Icons
You can customize the view of the table by using the options in the View Menu.

Table 5-2    Table Data Loading Status - View Menu/Icons and Description

View Menu/Icons Description

Columns You can manage which of the columns will be shown in the table
by clicking the Show All and Manage Columns options.

Detach and Detach icon 
You can view the table in the application in a separate window by

clicking Detach or by using the Detach icon .

Sort You can sort columns by the following options:

• Ascending
• Descending
• Advanced
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Table 5-2    (Cont.) Table Data Loading Status - View Menu/Icons and Description

View Menu/Icons Description

Reorder Columns You can reorder columns by clicking the Reorder Columns
option.

Query by Example and

Query by Example icon 

You can filter the items by one or multiple column values by
clicking the Query by Example option or by using the Query by

Example icon .

Data Loading Status Toolbar
The toolbar contains the following icons and buttons.

Table 5-3    Data Loading Status Toolbar - Icons/Buttons and Description

Icons/Buttons Description

Help icon 
You can access the online help for a particular page by clicking the

Help icon .

Refresh icon You can refresh the window by clicking the Refresh icon. All entries
are reset and not saved.

Save Click Save to save the entered records.

Save and Close Click Save and Close to save the entered records and close the
window.

Cancel Click Cancel to reject all entries and close the window.

Done If you open the window in view mode, the Done button is displayed.

Click Done to close the window.
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6
Download Blank Templates

The Download Blank Template window allows you to download blank templates which are
already present in the Merchandising solution.

1. You can access the Download Blank Template window from the Task menu, select
Foundation Data > Data Loading > Download Blank Template. The Download Blank
Template window appears.

2. In the Type field, select the template type from the list.

3. In the Template field, enter, select or search for the template you want to download.

4. Then choose one of the following options:

• Click Download to download the file.

• Click Revert to undo any changes.

5. Click Done to close the Download Blank Template Data window.
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7
Notifications

Notifications bring events within the application to your attention.

See the following examples:

• A simple, informative message indicating a long-running process has completed

• A message indicating a critical exception has occurred

• The store create request failed
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Figure 7-1    Notifications

Notification Badge
The Notification Badge displays the number of unread notifications for the user in the
sidebar menu. The Notification Badge displays '99+', when there are more than 99
notifications.

The notification count is periodically refreshed at regular intervals. This interval is
determined by a system-configured value.
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Notification Sidebar
When you click the Notification icon, the Notifications Sidebar is shown displaying the most
recent set of unread notifications (depending on the filter set).

Figure 7-2    Notifications Sidebar

Each component of the Notifications Sidebar is discussed in detail in the following sections:

Search Bar
A search bar at the top of the panel allows for searching through notifications. The search bar
has auto-suggest enabled, so it displays notifications as the user types.

Right next to the search bar is the 'List/Group' view toggle button. This causes the Notification
results to be displayed either in a flat or grouped view.
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Figure 7-3    Search Bar

Filtering Panel
The Filtering Panel allows you to filter notifications based on Creation time, Severity
and Type.

The values for the Time Periods and Severity components are pre-seeded constants.
The Type drop-down lists all the notification types available in the system.

When you click the Apply button, notifications that match the criteria are shown in the
Results Panel.

Chapter 7
Filtering Panel

7-4



Figure 7-4    Filtering Panel

Grouping Panel
This panel allows you to group notifications based on different attributes.

The values of the 'Group by' and the 'Then by' components are pre-seeded.

Figure 7-5    Grouping Panel

Results Panel - List View
When no selection is made in the Grouping Panel, the Results Panel displays notifications in
a list format.

The image below shows a simple search without any filtering or grouping.
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Figure 7-6    Results Panel - List View

1. Indicates that no filtering was done.

2. Notification Type - A description of the Type is displayed.

3. Read/Unread - A blue icon  is shown next to the notification if it is unread.

4. Notification Severity - A colored label indicating the severity of the notification is
shown.

5. Description - The description associated with the notification. If the notification was
designed to launch into a relevant flow, then this is displayed as a link. Otherwise,
the description is rendered as plain text.

6. Creation Time - A timestamp that shows the date and time at which the notification
was created.

7. User name - Creator of the notification.

Results Panel - Grouped View
Notifications are displayed in a grouped format within the Results Panel, when the
Group By drop-down in the Grouping Panel is selected.

Notifications are displayed in groups with three notifications shown for each group.
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Figure 7-7    Results Panel - Grouped View

1. Indicates the Group-By drop-down is selected on the Grouping Panel.

2. The value of the Group-By attribute. In this example, the results were grouped by
Notification Type. Hence the Notification Type is shown as the header of the group.

For each group, three notifications are shown followed by a 'See More' link. When you click
this link, up to 25 notifications are displayed for that group.

Results Panel - Summarized View
Notifications are summarized as shown in this example, when both the Group By and the
Then By drop-downs in the Grouping Panel are selected.

The summary view displays various groups and within them subgroups based on the
selections on the Grouping Panel. For each subgroup, a count of the notifications within that
subgroup, grouped by severity is displayed.

The example below depicts a grouping by department, then by class.
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Figure 7-8    Results Panel - Summarized View

1. Indicates that both options on the Grouping Panel have been selected.

2. First level of grouping is by Department. Here the first department shown is
'dept1'.

3. The subgroup within department 'dept1'. In this example, this is the Class name.

4. The number of notifications within that combination of Group and Subgroup.

5. A grouping by severity of all notifications within that combination of Group and
Subgroup.

6. The timestamp of the most recent notification of that combination of Group and
Subgroup.

All Notifications Tab
The All Notifications tab is shown when you click the 'See All' link at the bottom of the
Notifications side panel.
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Figure 7-9    All Notifications

This tab lists all the Notifications for the logged-in user, regardless of whether they are in
Read or Unread status. Information tiles display a break-up of the total notifications by
severity. Clicking these tiles refreshes the table below to display only those notifications that
are relevant to that tile.

You can perform the following operations from this tab.

• Delete  - The table allows for multiple selection and hence multiple notifications can
be deleted at a time. Use the row header to select the row.

• Refresh  - This refreshes the list of notifications in the table.

• Mark as Read - Multiple Unread Notifications can be marked as Read by clicking this
button.

• Mark as Unread - Multiple Read Notifications can be marked as Unread by clicking this
button.

• Reassign Notifications  - Notifications can be reassigned to individual recipients or a
group by clicking the Reassign Notifications icon. On selecting a row in the All
Notifications table, and clicking the icon, the reassign notification popup is displayed. The
Type is set to Reassigned by default, and the Severity and Description are pre-populated
from the selected row; you can then change any of these values and assign the
notification to one or more recipients.
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Figure 7-10    Reassign Notification

The All Notifications table displays the following columns:

• Notification Severity - A colored label indicating the Notification Severity.

• Status - If the status is unread, an icon  is shown. Otherwise it is blank.

• Description - The description of the notification itself.

• Type - The description of the Notification Type for the notification.

• Recipients - In case of individual notifications, this column contains the user ID of
the user to whom the notification is assigned. When the notification is assigned to
multiple users, it displays the text 'Multiple' and enables a context popup which
lists all the recipients. This field is empty when the notification is assigned to a
group associated with a type.

• Creation Date - Timestamp showing the date and time of creation.

• Created By - User ID of the user who created the notification.

• Last Updated Date - Timestamp showing the date and time when the last update
was made.

• Last Updated By - User ID of the user who last updated the notification.

• Application ID - Unique identifier that identifies the application. Not visible by
default.

• Department - The Department associated with the notification. Not visible by
default.
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• Class - The Class associated with the notification. Not visible by default.

• Subclass - The Subclass associated with the notification. Not visible by default.

• Location - The Location associated with the notification. Not visible by default.

• Supplier - The Supplier associated with the notification. Not visible by default.

• Performance - The Performance value associated with the notification. Not visible by
default.

• Brand - The Brand associated with the notification. Not visible by default.

• Rollup Count - The Rollup Count associated with the notification. Not visible by default.

• Additional Information - Refers to the Additional Information attribute associated with the
notification. Not visible by default.

Upload List
Use the browse button to select and upload a previously created data file that contains the
items you want to include.

Note:

The upload list must be created and saved as a .csv file.
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8
Add Items by Upload List

In several areas in Pricing, in addition to selecting individual items or an item list, you will be
provided an option for adding items titled Upload List. This option will allow you to browse for
a file of type .csv that contains a column of items. These items will then be applied to the
transaction similar to the way an item list is used, but without the need to create an item list in
advance. The .csv file does not require a template like other spreadsheet upload processes,
but instead uses just the data in the first column (all other data is ignored) of the first tab. The
upload also assumes that there is no header for the column.

All items that are valid for the transaction type can be included in the upload. For example, if
using to add items to a price change, either parent items or transaction items can be
included.

Figure 8-1    Add Item to Price Change
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